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 >   Find the home row.

•	Place your left hand over the keys  A   S   D   F   with one finger on each key.
•	Place your right hand over the keys  J   K   L   ;   with one finger on each key.
•	Now find the  enter/return   key and the  space   bar.
•	Use your thumb to tap the  space   bar.
•	Reach your  ;   finger to tap the  enter/return   key.

 >   Practice keyboarding.

•	Key the letters and spaces in each line below. Do not key the numbers.
•	Tap the  enter/return   key to start a new line.
•	When you finish, go to File/Save and save your work as Keyboarding 1.1.

1.	 a  space   s  space   d  space   f  space   j  space   k  space   l  space   ;  enter/return  

2.	 ad  space   sf  space   jl  space   k;  space   ad  space   sf  space   jl  enter/return  

3.	 fj  space   dk  space   sl  space   a;  space   dk  space   sl  space   a;  enter/return  

4.	 asdf  space   jkl;  space   asdf  space   jkl;  space   asdf  space   jkl;  enter/return  

5.	 sa  space   as  space   ld  space   dl  space   af  space   fa  space   ls  enter/return  

6.	 fl  space   lf  space   al  space   la  space   aj  space   sk  space   ks  enter/return  

7.	 a  space   as  space   ad  space   ask  space   lad  space   fad  enter/return  

8.	 as;  space   all;  space   ask  space   dad  space   ads;  space   asks  enter/return  

Home Row
 >   Check your posture before you start to key.

•	Sit up straight and place both feet flat on the floor.
•	Relax your shoulders and look at the screen.

Keyboarding
1.1
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 >   Find the delete or backspace key, arrow keys, and slide.

•	Find the  delete   key at the top right of the keyboard. On some keyboards there  
may be a key named backspace and a key named delete. If your keyboard has 
both of these keys, use the key named backspace.

•	Stretch your  ;   finger to tap the  delete   key.
•	Use  delete   to delete errors when typing. 
•	Find the arrow keys at the bottom right of the keyboard.
•	Use the arrow keys to move the cursor on the screen. 
•	Find the slide at the far right of the screen. 
•	 Use the mouse or touchpad to click and drag the slide to move the page up or down.

 >   Practice keyboarding.

•	Key the marks, words, and spaces in each line below. Do not key the numbers. 
•	When you finish, go to File/Save to save your work as Keyboarding 1.2.

1.	 Go to File/Open and open Keyboarding 1.1. 

2.	 Use the slide to find line number 2. Use the arrow keys to navigate to the beginning  
of the line.

3.	 Use the arrow keys and the  delete  key to delete the first and last letters in the line.

4.	 Use the arrow keys to move to line number 8.

5.	 Use the  delete   key to delete the first three words in the line.

Navigation
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
1.2
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 >   Find the keys.

•	Use your  D   finger to tap  E  .
•	Use your  J   finger to tap  H  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 1.3.

1.	 e  space   h  space   e  space   h  space   eh  space   he  space   ehe  space   heh  enter/return  

2.	 she  space   sells  space   sheds  enter/return  

3.	 he  space   flees  space   fleas  enter/return  

4.	 she  space   held  space   a  space   bee  enter/return  

5.	 ask  space   a  space   seal  enter/return  

6.	 a  space   lass  space   leads  enter/return  

7.	 he  space   shakes  space   a  space   leaf  enter/return  

Home Row Plus Keys E, H
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  F   finger to tap  G  .
•	Use your  K   finger to tap  I  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 2.1.

1.	 g  space   i  space   g  space   i  space   gi  space   ig  space   gig  space   igi  enter/return  

2.	 kid  space   disk  space   glad  enter/return  

3.	 lid  space   slid  space   gas  enter/return  

4.	 sigh  space   glide  space   gill  enter/return  

5.	 hike  space   hide  space   kiss  enter/return  

6.	 hail  space   sail  space   slide  enter/return  

7.	 she  space   has  space   a  space   high  space   glide  enter/return  

Keys G, I
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  F   finger to tap  R  .
•	Use your  L   finger to tap  O  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 2.2.

1.	 r  space   o  space   r  space   o  space   ro  space   or  space   ror  space   oro  enter/return  

2.	 rash  space   ride  space   rode  space   free  enter/return  

3.	 grill  space   frill  space   rage  space   ear  enter/return  

4.	 oil  space   foil  space   old  space   fold  enter/return  

5.	 or  space   roles  space   goal  space   rose  enter/return  

6.	 ride  space   a  space   seal  space   free  space   a  space   hog  space   reel  space    
a  space   fish  enter/return  

7.	 drill  space   a  space   hole  space   kiss  space   a  space   kid  space   roll  space    
a  space   log  enter/return  

Keys R, O
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Hold down the  shift   key as you tap a letter key to type a capital letter.
•	Use your  A   finger to hold down left-hand  shift  .
•	Use your  ;   finger to hold down right-hand  shift  .
•	Use your  L   finger to tap  .  .

 >   Practice keyboarding.

•	 Key the marks, words, and spaces in each line below. Do not key the numbers. 
•	When you finish, go to File/Save to save your work as Keyboarding 2.3.
•	Use the right-hand  shift   key to type these letters. 

1.	 A  space   S  space   D  space   F  space   AA  space   SS  space   DD  space   FF  enter/return  

2.	 G  space   E  space   R  space   GG  space   EE  space   RR  space   enter/return  

•	Use the left-hand  shift   key to type these letters. 

3.	 J  space   K  space   L  space   JJ  space   KK  space   LL  enter/return  

•	Use  shift   and  .   to type these abbreviations and names. 

4.	 Dr.  space   Jr.  space   Sr.  enter/return  

5.	 Dr.  space   Jill  space   D.  space   Mali  enter/return  

6.	 Dr.  space   R.  space   J.  space   Lee  space   enter/return  

7.	 Dr.  space   Sal  space   Dill  space   enter/return  

Shift Key, Period
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  F   finger to tap  T  .
•	Use your  J   finger to tap  U  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 3.1.

1.	 t  space   u  space   t  space   u  space   tu  space   ut  space   tut  space   utu  enter/return  

2.	 tile  space   toe  space   the  space   that  enter/return  

3.	 those  space   toast  space   tree  space   treat  enter/return  

4.	 feet  space   lost  space   roast  space   at  enter/return  

5.	 use  space   turf  space   rush  space   rude  enter/return  

6.	 rough  space   dust  space   rug  space   huge  enter/return  

7.	 sulk  space   hulk  space   tough  space   sole  enter/return  

Keys T, U
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  S   finger to tap  W  .
•	The  ?   is on the upper part of a key. 
•	Hold down  shift   with your  A   finger and use your  ;   finger to tap  ?  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the marks, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 3.2.

1.	 w  space  ?  space  w  space  ?  space  w?  space  ?w  space  www  space  ???  enter/return  

2.	 was  space   wash  space   were  space   war  enter/return  

3.	 wool  space   with  space   wig  space   wiggle  enter/return  

4.	 What?  space  Where?  space   How?  space  Will we?  enter/return  

5.	 Where  space   is  space   the  space   gold  space   kite?  enter/return  

6.	 Did  space  Wade  space   ask  space   for  space   a  space   kite?  enter/return  

7.	 Do  space   kids  space   like  space   kites?  enter/return  

8.	 Did  space   Julio  space   get  space   a  space   kite?  enter/return  

Keys W, ?
 >   Start from the home row.

•	Place your hands on the home row. 
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 >   Find the keys.

•	Use your  D   finger to tap  C  .
•	Use your  J   finger to tap  N  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 3.3.

1.	 c  space   n  space   c  space   n  space   cn  space   nc  space   cnc  space   ncn  enter/return  

2.	 cat  space   car  space   cart  space   chill  enter/return  

3.	 court  space   chat  space   cost  space   cleat  enter/return  

4.	 click  space   code  space   sack  space   noon  enter/return  

5.	 not  space   none  space   note  space   nose  space   north  enter/return  

6.	 sing  space   song  space   nothing  space   neck  space   cane  enter/return  

7.	 Did  space   he  space   get  space   a  space   cane?  enter/return  

8.	 She  space   does  space   not  space   get  space   a  space   code.  enter/return  

Keys C, N
 >   Start from the home row.

•	Place your hands on the home row. 

Keyboarding
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 >   Find the keys.

•	Use your  ;   finger to tap  P  .
•	Stretch your  F   finger to tap  B  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 4.1.

1.	 p  space  b  space  p  space  b  space  pb  space  bp  space  pbp  space  bpb  enter/return

2.	 ;  space   ;  space   ;  space   ;p;  space   pool  space   pack  enter/return  

3.	 pile  space   pail  space   spot  space   peek  space   spike  enter/return  

4.	 spool  space   phone  space   photo  space   spoons  enter/return  

5.	 ball  space   base  space   bike  space   pail  space   boot  enter/return  

6.	 bats  space   bees  space   basket  space   beard  space   beach  enter/return  

7.	 He  space    has  space   a  space   ball.  enter/return  

8.	 She  space   does  space   not  space   need  space   space.  enter/return  

Keys P, B
 >   Start from the home row.

•	Place your hands on the home row.
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 >   Find the keys.

•	Use your  J   finger to tap  M  .
•	Use your  ;   finger to hold down  shift  .
•	Stretch your  A   finger to tap  !  . Since there are two symbols on this key, 

you need to hold down the  shift   key when you type an exclamation point.
•	Remember to keep your other fingers on the home row. 

 >   Practice keyboarding.

•	Key the marks, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 4.2.

1.	 m  space   !  space   m  space   !  space   m!  space   !m  space   m!m  space   !m!  enter/return

2.	 moon  space   month  space   mess  space   lamp  enter/return  

3.	 come  space   melting  space   mother  space   much  enter/return  

4.	 mile  space   smile  space   lump  space   Jump!  enter/return  

5.	 What  space   luck!  enter/return  

6.	 She  space   won  space   the  space   race!  enter/return  

7.	 How  space   nice  space   this  space   is!  enter/return  

8.	 What  space   a  space   great  space   trick!  enter/return  

Keys M, !
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  A   finger to tap  Q  .
•	Stretch your  J   finger to tap  Y  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 4.3.

1.	 q  space   y  space   q  space   y  space   qy  space   yq  space   qyq  space   yqy  enter/return

2.	 year  space   yellow  space   young  space   your  enter/return  

3.	 youth  space   yield  space   yesterday  space   lightly  enter/return  

4.	 quick  space   slowly  space   quit  space   quickly  enter/return  

5.	 Please  space   be  space   quiet!  enter/return  

6.	 Run  space   quickly!  enter/return  

7.	 Go  space   home!  enter/return  

8.	 Try  space   this  space   quick  space   trick!  enter/return  

Keys Q, Y
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  F   finger to tap  V  .
•	Use your  A   finger to tap  Z  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 5.1.

1.	 v  space   z  space   v  space   z  space   vz  space   zv  space   vzv  space   zvz  enter/return  

2.	 vote  space   visit  space   vary  space   vine  enter/return  

3.	 view  space   every  space   vane  space   oven  enter/return  

4.	 zoo  space   zero  space   zany  space   zebra  enter/return  

5.	 zoom  space   hazel  space   zone  space   zither  enter/return  

6.	 Zoe  space   had  space   a  space   golf  space   lesson.  enter/return  

7.	 Devon  space   was  space   the  space   teacher.  enter/return  

8.	 Victor  space   and  space   Zoe  space   plan  space   to  space   practice.  enter/return  

Keys V, Z
 >   Start from the home row.

•	Place your hands on the home row.
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 >   Find the keys.

•	Use your  S   finger to tap  X  .
•	Use your  K   finger to tap  ,  .
•	Remember to keep your other fingers on the home row. 
•	Try to keep your eyes on the screen as you type. 

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 5.2.

1.	 x  space   ,  space   x  space   ,  space   x,  space   ,x  space   x,x  space   ,x,  enter/return  

2.	 extra  space   exams  space   exit  space   lax  enter/return  

3.	 lax,  space   exam,  space   exits,  space   extras,  enter/return  

4.	 tax  space   relax  space   fox  space   box  enter/return  

5.	 relaxes,  space   boxes,  space   taxes,  space   foxes,  enter/return  

6.	 excellent  space   expert  space   six  space   sixteen  enter/return  

7.	 He  space   has  space   sixteen  space   boxes.  enter/return  

8.	 The  space   quick,  space   quiet  space   fox  space   is  space   here.  enter/return  

Keys X, Comma
 >   Start from the home row.

•	Place your hands on the home row.

Keyboarding
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 >   Find the keys.

•	Use your  ;   finger to tap  ‘  .
•	Use your  A   finger to hold the left  shift  .
•	Use your  ;   finger to tap  :  .
•	Use the  ‘   key to show contractions and possessives.
•	Use the  :   key to introduce a list or to separate the minutes and hours when 

showing the time.

 >   Practice keyboarding.

•	Key the letters, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 5.3.

1.	 ‘  space   :  space  ‘  space   :  space  ‘:  space   :’  space  ‘:’  space   :’:  enter/return  

2.	 Tanya’s  space   book,  space   Ramsey’s  space   pen  enter/return  

3.	 Carmen’s  space   markers,  space   Juan’s  space   paper  enter/return  

4.	 When:  space  Where:  enter/return  

5.	 Follow  space   these  space   steps:  enter/return  

6.	 The  space   game  space   starts  space   at  space   4:15  space   p.m.  enter/return

Keys ‘, :
 >   Start from the home row.

•	Place your hands on the home row. 

Keyboarding
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 >   Review typing the alphabet. 

•	You have learned to type all the letters of the alphabet and many symbols.
•	Sometimes you may need to type capital letters quickly. 
•	Use your  A  key finger to tap the  caps lock   key. This will make the letters you 

type uppercase, or capital.
•	When typing do not overuse capital letters. It can make it seem as though 

you are shouting.

 >   Practice keyboarding.

•	Tap the  caps lock   key to turn caps lock on. Tap  caps lock   again to turn it off. 
•	Key the letters in each line shown below. 
•	When you finish, go to File/Save and save your work as Keyboarding 6.1.

1.	 abcdefghijklmnopqrstuvwxyz  enter/return  

2.	 caps lock   ABCDEFGHIJKLMNOPQRSTUVWXYZ  caps lock   enter/return  

3.	 AaBbCcDdEeFfGgHhIiJjKkLlMmNnOoPpQqRrSsTtUuVvWwXxYyZz  enter/return  

4.	 Aaa FfF sSs dDD jjJ Kkk LLl hhH bBb hhH  caps lock   WXYZ  caps lock   enter/return  

•	Repeat lines 1–4. 
•	Type a previously written essay. Make sure it is at least one half of a page.  

Use the  caps lock   twice.

Alphabet Review and Caps Lock
 >   Check your hand position before you start to key.

•	Place your hands on the home row.
•	Keep your wrists slightly raised.
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Insert or Delete Text
 >   Position the cursor in the document.

•	Use the touchpad or mouse to move the cursor to where you want to add 
or delete text in a document. Then tap the touchpad or click the mouse.

 >   Insert or delete a letter, word, or line.

•	Type to insert the text you want to add.  
•	To delete a letter, place the cursor in front of the letter. Tap  delete  
•	To delete a word, place the cursor on the word. Double click by quickly 

tapping the touchpad twice or clicking the mouse twice. Tap  delete  
•	To delete a line, place the cursor on the line. Triple click by quickly tapping 

the touchpad or clicking the mouse three times. Tap  delete  

 >   Practice keyboarding.

•	Key the sentences below. Do not key the numbers. 
•	Follow the directions to insert or delete text.
•	When you finish, go to File/Save to save your work as Keyboarding 6.2.

1.	 Hannah  space   went  space   to  space   School  .   enter/return  

•	 Delete the capital S in the word school. Insert a lowercase s.

2.	 Do  space   you  space   have  space   the  space   car  space   keys  shift   ?   enter/return  

•	 Delete the word car. Insert the word house. 

3.	 Mom  space   said  space   I  space   could  space   go  .   enter/return  

•	 Delete the word could. Insert the word will. 

4.	 The  space   boys  space   and  space   girls  space   hoped  space   for  space   a 
space   sunny   space   day  .   space  They  space   were  space   ready  space   for 
space   their  space   class  space   picnic  .   enter/return  

	 If  space   it  space   rained  ,   they  space   would  space   have  space   to 
space   cancel  space   their  space   plans  .   enter/return  

•	 Delete the last two lines of text.

Keyboarding
6.2
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 >   Find the quotation mark key.

•	Find the  “   key next to the  ;   key.
•	Use your  A   key finger to hold down the  shift   key.
•	Use your  ;   key finger to tap the  “   key.
•	When typing quotations, keep commas and periods inside the ending 

quotation mark. 

 >   Practice keyboarding.

•	Key the marks, words, and spaces in each line below. Do not key the 
numbers. 

•	When you finish, go to File/Save to save your work as Keyboarding 6.3.

1.	 shift   “   I  space   have  space   the  space   house  space   keys  ,   shift   “  
space   Ricardo  space   said  .   enter/return  

2.	 shift   “   Please  space   open  space   the  space   door  ,   shift   “   space   Marissa 
space   said  .   enter/return  

3.	 shift   “  Why  shift   ?   shift   “   space   asked  space   Stephan  .   enter/return  

4.	 Did  space   you  space   hear  space   the  space   teacher  space   say  ,   space   shift  
“   Stop  shift   “   shift   ?   enter/return  

5.	 Ava  space   said  ,   space   shift   “   Hurry  shift   !   shift   “   enter/return  

Quotation Marks
 >   Start from the home row.
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 >   Use the command key as a shortcut for type treatments.

•	To turn on italic, hold down  command   with your  A   finger and tap  I  . Hold 
command   and tap  I   again to turn italic off.

•	To turn on bold, hold down  command   with your  A   finger and tap  B  . Hold 
command   and tap  B   again to turn bold off.

•	To turn on underscore, hold down  command   with your  A   finger and tap  U  . 
Hold  command   and tap  U   again to turn underscore off.

 >   Practice keyboarding.

•	Key the sentences shown below. Do not key the numbers. Use the shortcuts 
you learned. 

•	When you finish, go to File/Save and save your work as Keyboarding 7.1.

1.	 I enjoyed reading the book A Wrinkle in Time.  enter/return  

•	Change the book title to italic.

2.	 First plant the seed. Next water the seed. Last give the plant sunlight.  enter/return

•	Change the words First, Next, and Last to bold.

3.	 The title of my essay is My Favorite Vacation.  enter/return  

•	Underscore the essay title.

Italic, Bold, Underscore
 >   Understand type treatments.

•	 Words can be set in italic, bold, or have an underscore.
•	To set or change text types, highlight the text you want to change and 

click on the option for italic, bold, or underscore.
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Tab and Alignment
 >   Use the tab key to indent paragraphs.

•	The  tab   key is next to the  Q  . Use your  A   finger to reach  tab  .

 >   Align text on the left, right, or center.

•	Place your cursor at the beginning of the text you want to align. 
•	To align the text on the left, hold down  command   and tap  L  .
•	To align the text in the center, hold down  command   and tap  E  .
•	To align the text on the right, hold down  command   and tap  R  .

 >   Use bullets and numbering.

•	Place your cursor at the beginning of the text you want to bullet or 
number. 

•	Find the bullets and numbering options at the top of the document. 
•	Click on them to add these features. Click on them again to remove them. 

 >   Practice keyboarding.

•	Key the text below. Then follow the bulleted directions.
•	When you finish, go to File/Save to save your work as Keyboarding 7.2.

	 tab   Congratulations! You have practiced many keyboarding skills. Now, 
be sure to practice to improve your skills. You will be able to do the 
following:  enter/return   Type quickly.  enter/return   Make fewer mistakes. 
enter/return   Save time.  enter/return   Focus on your ideas instead of on the 

keyboard.  enter/return  

•	Align the lines that come after the first  enter/return   on the left.
•	Align the same lines in the center.
•	Set the lines as a bulleted list. 
•	Set the lines as a numbered list.

Keyboarding
7.2
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 >   Find the numbers 2, 7, 1, 9. 

•	Place your hands on the home row.
•	Use your  S   finger to type the  2   key.
•	Use your  J   finger to type the  7   key.
•	Use your  A   finger to type the  1   key.
•	Use your  K   finger to type the  9   key.

 >   Practice keyboarding.

•	Key the marks, words, and spaces in each line below. Do not key the 
numbers at the beginning of each line.

•	When you finish, go to File/Save to save your work as Keyboarding 7.3.

1.	 11; 99; 1999  enter/return  

2.	 There are 19 members of the gymnastics team.  enter/return  

3.	 The team competed in the local meet on June 1.  enter/return  

4.	 The 19 members won 7 blue ribbons.  enter/return  

5.	 They also won 9 red ribbons and 1 white ribbon.  enter/return  

6.	 This is the best the team had done since 1972.  enter/return  

7.	 On May 27 of that year, the team won 12 blue ribbons.  enter/return  

Numbers 2, 7, 1, 9
 >   Find the number row above the top row of letters. 

Keyboarding
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 >   Find the numbers. 

•	Start from the home row.
•	Stretch your  F   finger to type  4  .
•	Stretch your  ;   finger to type  0  .
•	Stretch your  D   finger to type  3  .
•	Stretch your  J   finger to type  6  .
•	Stretch your  F   finger to type  5  .
•	Stretch your  K   finger to type  8  .

 >   Practice keyboarding.

•	Key the marks, words, and spaces in each line below. Do not key the 
numbers at the beginning of each line.

•	When you finish, go to File/Save to save your work as Keyboarding 8.1.

1.	 400; 1940; 40 years; 336; 160 meters; 360 degrees  enter/return  

2.	 580; 1958; 85 yards; 58 degrees; Game 5; Route 88  enter/return  

3.	 0 tigers; 11 lions; 22 bears; 33 wolves; 44 seals; 55 deer; 66 camels; 77 walruses; 
88 monkeys; 99 alligators; 100 elephants  enter/return  

4.	 There are 58 students at the camp. They need 15 backpacks. They will be 
hiking 8 miles. The trip will cost 20 dollars.  enter/return  

Numbers 4, 0, 3, 6, 5, 8
 >   Find the number row. 

•	Place your fingers on the home row. 
•	Numbers appear at the top of the keyboard and sometimes in a number 

pad on the right side of the keyboard. 
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 >   Find the keys. 

•	Copy, cut, and paste shortcuts use the  command   key. On some computers, this 
key may be labeled CTRL.

•	To copy the text, hold down the  command   key and tap the  C   key.
•	To cut the text, hold down the  command   key and tap the  X   key.
•	To paste the text, hold down the  command   key and tap the  V   key.
•	To move text on a page, first copy the text. Then, cut the text to remove it. 

Next, use the mouse or arrow keys to move the cursor where you want to 
place the text. Paste the text in the new location. 

 >   Practice keyboarding.

•	Key the sentences shown below. Use the shortcuts you learned. 
•	When you finish, go to File/Save to save your work as Keyboarding 8.2.

	 Copy, cut, and paste can help you save time when you are keyboarding. 
If you type something in the wrong place, you do not have to redo it. You can 
copy, cut, and paste it where it belongs.  enter/return  

•	Copy, cut, and paste the first sentence on a new line. 
•	Write something of your own and practice these functions.

Copy, Cut, and Paste
 >   Learn about functions. 

•	Copy, cut, and paste save time when rearranging words or images on a 
page of text.

Keyboarding
8.2

space

A S D F G H J K L :
;

”
’

Z X C V B N M <
,

>
.

?
/

~
`

!
1

@
2

#
3

$
4

%
5

^
6

&
7

*
8

(
9

)
0

—_ +
= delete

Q W E R T Y U I O P {
[

}
]tab

|
\

cap lock
enter/
return

shift

command command

command command

shift

© Houghton Mifflin Harcourt Publishing Company. All rights reserved.

Grade 3 Printable



Name

Fonts, Colors, Highlight
 >   Learn about functions. 

•	Now that you can type one-half of a page of text, you may want to 
change the font. The font is the style of type or printed text.

•	You may also want to make the text a different color or highlight parts of 
your text. Using color helps bring attention to parts of your writing.

 >   Find the tools. 

•	To choose a font, click the “Home” tab in the ribbon. Choose the font and 
size from the drop-down boxes in the ribbon. For most documents, 
12-point type is appropriate. 

•	To change the font color, click the “Home” tab in the ribbon. Find the 
button with an underlined A. Click the small arrow next to the button. 
Select the font color. 

•	To highlight text, first double click or use the mouse or touchpad to click 
and drag to select the text you want to highlight. Then click the “Home” 
tab in the ribbon. Find the button with a yellow underlined “abc” on it. 
Click the small arrow next to the button. Click the highlight color.  

 >   Practice keyboarding.

•	Key the paragraph below. Then follow the directions to change the font 
and insert highlighting.

•	When you finish, go to File/Save to save your work as Keyboarding 8.3.

	 Changing the font or adding some color to your text is not hard at all. 
It only takes a few simple steps. You can even highlight sentences to bring 
attention to parts of your writing.  enter/return  

•	Change the font of the first sentence. Change the color of the second 
sentence. Highlight the third sentence.

•	Type a previously written one-half-page essay. Practice selecting a font, 
changing text color, and highlighting parts of the essay.

Keyboarding
8.3
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Spell Check
 >   Learn about spell check. 

•	Spell check is a valuable tool used to locate and correct errors in spelling. 
•	Always run spell check on a piece of writing before turning it in.

 >   Find the tool. 

•	Click the “Review” tab in the ribbon.
•	Click the “Spelling and Grammar” button. 
•	The first spelling error will be shown. 
•	 If the correct spelling of the word is in the list of “Suggestions,” click to 

select it. 
•	Sometimes spell check may highlight a word that it thinks is misspelled. 

This often happens with words from other languages. If this happens, 
click “Ignore” to ignore the error.

•	Click “Cancel” when spell check is complete. 
•	Most word processing programs will also show spelling errors as they are 

typed by showing a red line under the misspelled word.
•	Even though spell check is a great tool, it does not take the place of 

proofreading for spelling errors. Spell check may not find spelling errors 
in names or confuse words such as your and you’re or its and it’s.

 >   Practice keyboarding.

•	Key the sentences below. There are words included that are misspelled. 
Key the misspelled words as they are shown. Then follow the directions to 
correct the errors.

•	When you finish, go to File/Save to save your work as Keyboarding 9.1.

	 Sumtimes it can be hard to see mispelled werds when you type. That is 
why spell chek is an important tule. It points out the errors so you can 
corect them. This helps you improov your writing.  enter/return  

•	Run spell check. Use the tool to help you correct the errors.
•	Open a piece of writing you have completed recently. Run spell check. 

Correct any spelling errors you find.  

Keyboarding
9.1
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Grammar Check
 >   Learn about grammar check. 

•	Grammar check is another valuable tool that can improve writing. 
•	Grammar check locates errors in the grammar used in writing.  
•	Always run grammar check on a piece of writing before turning it in.    

 >   Find the tool. 

•	Click the “Review” tab in the ribbon.
•	Click the “Spelling and Grammar” button. 
•	The first error will be shown.   
•	Click to select the change, or click “Ignore” to ignore the correction.
•	Click “Cancel” when the grammar check is complete. 
•	Most word processing programs will also show grammar errors as they 

are typed by showing a green line under the error. 
•	Even though grammar check is a great tool, it does not take the place of 

proofreading to locate errors in grammar and usage. 

 >   Practice keyboarding.

•	Key the sentences below. There are mistakes in grammar included. Key 
the mistakes as they are shown. Then follow the directions to correct the 
errors.

•	When you finish, go to File/Save to save your work as Keyboarding 9.2.

	 Sometimes grammar errors can really. sneak up on you. That is why 
grammar check are so helpful. It help you find mistakes you have made. 
This help you improve your grammar and writing.  enter/return  

•	Run grammar check. Use the tool to help you correct the errors.
•	Open a piece of writing you have completed recently. Run grammar 

check. Correct any grammar errors you find.  

Keyboarding
9.2
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Dictionary
 >   Learn about the tool. 

•	The dictionary tool provides definitions, or meanings, of words. 
•	Use the dictionary tool to double check the meaning of words that are 

used when writing.

 >   Find the tools. 

•	First, highlight the word to check. 
•	Pull down “Tools” from the menu and click “Dictionary.”  
•	The dictionary pop-up box will appear. 
•	The pop-up box will include definitions for the word. 
•	Click the link at the bottom of the pop-up box to see more definitions and 

information about the word.  

 >   Practice keyboarding.

•	Key the words listed below. Do not key the numbers.  
•	Use the dictionary function to look up the definitions of the words below. 

Add the definitions to the words. 
•	When you finish, go to File/Save to save your work as Keyboarding 9.3.

1.	 profound

2.	 pursuit

3.	 cynic

4.	 mundane

5.	 sumptuous

6.	 luminous

Keyboarding
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Thesaurus
 >   Learn about the tool. 

•	The thesaurus tool helps you find synonyms for overused words.  
•	When using the thesaurus tool, it is important to understand the shades 

of meaning among similar words. Use the dictionary function to check 
the meaning of unfamiliar words found in the thesaurus to ensure the 
shades of meaning agree. 

 >   Find the tool.  

•	Highlight the word you want to change.
•	Click the “Review” tab in the ribbon and click “Thesaurus.” A pop-up menu 

will appear.
•	A short list of synonyms will appear. Click to select a word. Click “Insert.”
•	Next to the “Insert” button is the “Look Up” button. Use this to find the 

meaning of the synonym.

 >   Practice keyboarding.

•	Key the words listed below. Do not key the numbers.  
•	Use the thesaurus tool to look up the synonyms. List the synonyms next 

to the word.  
•	When you finish, go to File/Save to save your work as Keyboarding 10.1.

1.	 said

2.	 went

3.	 happy

4.	 sad

5.	 big

6.	 small
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Spanish Punctuation
 >   Learn about Spanish marks.

•	Many Spanish words and names use special marks called accent marks. 
These are often on letters e, i, a, u, o, and n. 

•	Spanish also uses different punctuation marks in sentences.
•	These punctuation marks look like upside down question marks and 

exclamation points. They appear at the beginning of sentences.  

 >   Find Spanish punctuation.

•	Symbols and special characters can often be found in a special menu 
under the “Insert” menu.

•	For é, í, or another letter with an accent mark, press the  option   key  E   key 
and then the letter.

•	For ñ, press the  option   key  N   key and then the  N   key.
•	For ¡,  press  option   key  !   key.
•	For ¿,  press  option   key  ?   key.
•	You can also use shortcuts. Press and hold down the letter e, i, a, o, u, or n.  

A pop-up appears. Click on the letter with the accent mark you need. 

 >   Practice keyboarding.

•	Key the sentences and special marks below. Do not key the numbers.
•	When you finish, go to File/Save to save your work as Keyboarding 10.2.

1.	 Juan de Oñate was born in New Spain. His father was Cristóbal de Oñate. 
Juan took a journey to Nueva México. He crossed the Río del Norte. 
enter/return  

2.	 ¿Dónde están los estudiantes? ¡Están aquí! ¿Pueden escribir en español? 
¡Sí!

Keyboarding
10.2

© Houghton Mifflin Harcourt Publishing Company. All rights reserved.

Grade 3 Printable



Name

Words per Minute
 >   Learn how to calculate words per minute. 

•	To calculate your words per minute rate, type for one minute. Count the 
total number of words you typed. Subtract the errors you made. This is 
your WPM (words per minute) score.

 >   Set your words per minute goal.

•	Try to type between 10 and 20 words per minute. 
•	Keep practicing to increase your words per minute rate. 

 >   Practice keyboarding.

•	Key the sentences below. You will have one minute.  
•	When time is up, calculate the WPM score. Type the score at the bottom of 

the page. 
•	Go to File/Save to save your work as Keyboarding 10.3.

	 tab   Congratulations! You have practiced many keyboarding skills. 
Now, be sure to practice. If you practice, your skills will improve. 
You will be able to do the following: Type quickly.  enter/return   Make few 
mistakes.  enter/return   Save time.  enter/return   Focus on your ideas instead 
of the keyboard.  enter/return   tab   In addition, good keyboarding skills 
can help you become a better writer. Keyboarding becomes quick and 
easy. You can think about your ideas and your sentences. So, keep 
practicing!  enter/return  

	 WPM Score:

•	Continue practicing by typing one-half of a page. Calculate your WPM 
score.

	 WPM Score:
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